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Cut Manager is a separate application which allows you to control how your Flexi files are cut or printed.

Cut Manager Help is divided into the following major areas:

Menu Commands

Cut Manager Window

Contacting Product Support

Network users: If you have a Windows for Workgroups network, you can set up Flexi to send cut jobs to 
another computer on your network. Options which only affect users working across a network are marked 
with the following symbol:

Windows for Workgroups users only
If you do not have a network, you can skip any topics marked with this symbol.

When this symbol appears in a topic's banner, the topic discusses a feature that is only included 
in FlexiSIGN-PRO. Only FlexiSIGN-PRO includes features related to large-format color printing.
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Job Info... (File Menu)
Displays information on the job selected in the Job list. A different dialog box is displayed for cut jobs, print
jobs, and contour jobs. To select a job, click on its file name or color name in the Job list. (The Job 
Information dialog box can also be displayed by double-clicking the job name in the Job list.)

NOTE If the selected job is a plot file or print file that was loaded using the Add Job command on the 
File menu, the Job Information dialog box is not available and the Job Info command is dimmed.

Cut Job Information
File Name:    Shows the complete name and path of the selected cut job.

Job Length:    Shows the length of a single copy of the selected cut job.

Job Height:    Shows the height of a single copy of the selected cut job.

Offset X:    Shows how far each page is shifted horizontally from the plotter's origin.

Offset Y:    Shows how far each page is shifted vertically from the plotter's origin.

Copies:    Shows the number of copies of the job which will be cut; can be changed in the Job list.

Destination:    Shows the final destination of the job after it is cut. The destination can be changed
using the Dest list box in the Job list; the default destination is selected using the Preferences
command.

Color Display:    Shows the color of the selected cut job. (If Plot all colors was selected in Flexi, a 
multi-colored rectangle is shown.)

Color Name:    Shows the color name of the selected cut job. (If Plot all colors was selected in 
Flexi, "Multiple" is shown.)

Vendor:    For colors loaded from the Vinyl Library, displays the vinyl manufacturer.

Type:      For colors loaded from the Vinyl Library, displays the vinyl type.

Part #:      For colors loaded from the Vinyl Library, displays the manufacturer's part number for the
vinyl.

Notes:    Displays any notes added to the color in the Color Specs dialog box.

Comments:    Displays any comments added in the Color Info dialog box in Flexi when the job 
was sent to Cut Manager. Also, allows you to enter additional comments.

Sender:    Name of the Flexi station from which the job was sent.

Cancel button:    Closes the Cut Job Information dialog box without saving changes made to the 
Comments entry box.

OK button:    Saves changes made to the Comments entry box and closes the Cut Job 
Information dialog box.

Print Job Information
File Name:    Shows the complete name and path of the selected print job.

Job Length:    Shows the length of a single copy of the selected print job.

Job Height:    Shows the height of a single copy of the selected print job.

Offset X:    Shows how far each image is shifted horizontally from the printer's origin.

Offset Y:    Shows how far each image is shifted vertically from the printer's origin.

Copies:    Shows the number of copies of the job which will be printed; can be changed in the Job 
list.

Destination:    Shows the final destination of the job after it is printed. The destination can be 



changed using the Dest list box in the Job list; the default destination is selected using the 
Preferences command.

Comments:    Displays any comments entered when the job was sent to Cut Manager from the 
FlexiPRINT dialog box. Also, allows you to enter additional comments.

Sender:    Name of the Flexi station from which the job was sent.

Media:    Displays the name of the media on which the job should be printed.

Ink:    Displays the name of the ink with which the job should be printed.

NOTE Always print the job using the media and ink shown here! FlexiSIGN-PRO processes the file 
assuming that these materials will be used. If they are changed without resending the file from the
FlexiPRINT dialog box with the correct settings, you may get unsatisfactory results.

Print as separations:    Prints each of the selected colors (CMYK) in black on a separate sheet.

Cancel button:    Closes the Print Job Information dialog box without saving changes made to the
Comments entry box.

OK button:    Saves changes made to the Comments entry box and closes the Print Job 
Information dialog box.

Contour Job Information
File Name:    Shows the complete name and path of the selected contour job.

Job Length:    Shows the length of a single copy of the selected contour job.

Job Height:    Shows the height of a single copy of the selected contour job.

Offset X:    Shows how far each image is shifted horizontally from the cutter's origin.

Offset Y:    Shows how far each image is shifted vertically from the cutter's origin.

Copies:    Shows the number of copies of the job which will be cut; can be changed in the Job list.

Destination:    Shows the final destination of the job after it is cut. The destination can be changed
using the Dest list box in the Job list; the default destination is selected using the Preferences
command.

Comments:    Displays any comments entered when the job was sent to Cut Manager from the 
FlexiPRINT dialog box. Also, allows you to enter additional comments.

Sender:    Name of the Flexi station from which the job was sent.

OK button:    Saves changes made to the Comments entry box and closes the Contour Job 
Information dialog box.

See Also
Job list

Chapter 5, Using Color



Save Job... (File Menu)
Saves the selected job to the specified name and location and removes it from the Job list without cutting 
or printing it.

To remove a job from the list without saving it, click the Delete button at the bottom of the Cut 
Manager window.

To have Cut Manager automatically save a file to the default archive directory (chosen in Cut 
Manager Preferences) after it has cut or printed, choose Archive from the Dest list box in the 
Job list.

See Also
Preferences

Cut Manager Window

Job list



Add Job... (File Menu)
Displays the Open Plot File dialog box and allows you to load a plot file, print file, or archived cut job or 
print job into the Job list for the current plotter or printer. Use the List Files of Type list box to choose the 
type of file you wish to open:

To open a plot file in the HPGL format, choose Plot Files (*.plt) from the List Files of Type list box.

To open an archived cut job, choose All Files (*.*) from the List Files of Type list box.

See Also
Job list



Start Job (File Menu)
Sends the job at the top of the Job list to cut or print. For this command to work, the job at the top of the 
list must be on ready status (green light).

NOTE You can also send a job to cut or print by clicking the Start button at the bottom of the Cut 
Manager window.

To release a job on hold (red light) and put it on ready status, select the job by clicking its name or
color and click the Release button at the bottom of the Cut Manager window.

See Also
Job list

Cut Manager Window



Preferences... (Edit Menu)
Allows you to change and save Cut Manager's default settings. The following options are included in this 
dialog box:

Sort by:    Determines the order in which cut jobs are plotted. There are two options:

- Job name: Plots every color layer in a sign and then moves on to the next sign in the Job 
list.

- Color: Sorts all of the cut jobs for the active plotter by color and plots jobs which are the 
same color at the same time. This option allows you to change media less often when 
cutting multiple signs which use the same colors.

NOTE This setting does not affect print jobs, as every print job's color name is CMYK.

Display Units:    Allows you to choose the units of measurement displayed in Cut Manager. 
Options are English (all units display in inches) and Metric (all units display in meters).

Allow remote Send Now/Interactive:    When selected, allows designers using Flexi on other 
computers to send jobs on ready status (green light) and to use interactive features (such as Poll Size 
and Show Me) in the Cut/Plot and Fill Plot dialog boxes. When deselected, remote users can only send 
jobs on hold status and interactive features are not available over the network. (This option only affects 
remote users on a Windows for Workgroups network.)

NOTE Allow remote Send Now/Interactive is turned off as a safety feature. When Allow remote Send 
Now/Interactive is selected in Preferences and Auto start is turned on in the Cut Manager 
window, jobs from remote users may start unexpectedly! Before selecting both of these options, 
make sure that all personnel who use the Cut Manager station are aware that a job may start 
suddenly; this simple safety precaution can prevent injuries.

After job is completed:    Allows you to choose the default destination (after plotting) of every cut 
job. You can also change the destination of an individual job in the Job list. Choices are:

- Archive:    Saves all jobs to a folder on the hard drive. When this option is selected, a dialog
box is displayed asking you to specify the folder to use. Plot files and print files cannot be 
archived.

- Delete job:    Deletes all jobs after they cut or print.

- Hold job:    Places a hold on each job after it cuts or prints and places it at the bottom of the
Job list.

Display message when Cut Manager needs your attention:    When selected, displays an alert 
on your screen whenever Cut Manager needs user action to continue cutting or printing.

Audible alarm before starting job:    When selected, tells the computer running Cut Manager to 
beep once when a job begins cutting or printing.

Audible alarm after ending job:    When selected, tells the computer running Cut Manager to 
beep twice after each job is complete.

Data file directory:    Allows you to choose where Flexi stores the jobs which appear on the Job 
list. To change the location of this temporary storage area, click the Change Directory button, 
move to the desired directory in the dialog box which is displayed, and click OK.

See Also
Auto start

Job list



Port Setup... (Port Menu)
Allows you to create, modify, and delete plotter setups and color printer setups on the displayed port 
setup. Before plotting or color printing your first sign, you need to create a port setup for each port (for 
example, com1 or lpt2) you will be using; as you do this, you will also create a setup for the cutter and/or 
printer that will use that port. Each setup contains the information needed to cut or print each sign 
properly, such as the brand and model of the cutter or printer, media size information, and how your 
computer and the cutter or printer should communicate.

To set up a new cutter or plotter or to change an existing plotter setup, choose the Port Setup 
command from the Port menu. If you are using FlexiSIGN-PRO, you should then choose 
Plotter from the cascading menu.

To set up a new large-format color printer or to change an existing printer setup, choose the Port 
Setup command from the Edit menu and then choose Printer from the cascading menu. 
(FlexiSIGN-PRO only.)

NOTE Only large-format color printers have to be set up this way. To change the setup on a laser printer 
or a desktop color printer such as an HP DeskWriter 550C, use the Print Setup command on 
Flexi's File menu.

To change the displayed port setup, choose a different port setup from the Port list box in the Cut 
Manager window.

To create a new port setup, use the Add Port Setup command on the Port menu.

NOTE You can also display the Port Setup or Color Printer Setup dialog box from Flexi by choosing the 
Plotter or Color Printer option from the Setup cascading menu on the Edit menu. You cannot 
display either of these dialog boxes if a job is currently cutting or printing to the displayed port or if
there are jobs on ready status and Auto start is turned on.

See Also
Help
Add Port Setup

Cut Manager Window



Add Port Setup... (Port Menu)
Allows you add a new port setup on any unused port and create plotter setups for the new port setup. 
Before plotting or color printing your first sign, you need to create a port setup for each port (for example, 
com1 or lpt2) you will be using; as you do this, you will also create a setup for the cutter and/or printer that
will use that port. Each setup contains the information needed to cut or print each sign properly, such as 
the brand and model of the cutter or printer, media size information, and how your computer and the 
cutter or printer should communicate.

- To add a port setup for a new cutter or plotter that will be on a different port than existing 
setups, choose the Add Port Setup command from the Port menu. If you are using 
FlexiSIGN-PRO, you should then choose Plotter from the cascading menu.

- To add a new port setup for a new large-format color printer that will be on a different port 
than existing setups, choose the Add Port Setup command from the Port menu and then 
choose Printer from the cascading menu.

NOTE You must set up at least one plotter or printer for each port setup you create.

To change the displayed port setup, choose a different port setup from the Port list box on the Cut 
Manager window.

To create or modify a plotter or color printer setup on an existing port setup, or to move all plotters 
in a port setup to a different port, use the Port Setup command on the Port menu.

See Also
Help
Port Setup

Cut Manager window



Delete Port Setup (Port Menu)
Deletes the displayed port setup, all its plotter setups and printer setups, and any jobs waiting for those 
plotters or printers.

NOTE You must have at least one port setup to use Cut Manager; if you have only one port setup, you 
cannot delete it. You cannot delete a port setup while a job is cutting or printing from it.

To change the displayed port setup, select a new port setup from the Port list box in the Cut 
Manager window.

See Also
Cut Manager Window



Contacting Product Support
If you have any questions about how to use Cut Manager that you cannot answer by referring to this help 
or the manual, call our product support line. To answer questions about your computer or cutter, please 
contact your hardware dealer. Our product support personnel cannot answer questions concerning your 
hardware.

Before calling for help, look at the appropriate sections of the manual to try to solve the problem. If you 
still cannot find the answer you need, write down the following information before you call:

- User number found on the key

- Name and version of Flexi product

- Version of Windows system software

- Version of ATM (if applicable)

- Numbers of fonts installed (ATM and TrueType)

- Brand, model, and type of PC

- Amount of RAM installed

- Amount of free space on disk

- Type of video card

- Virtual memory setting

- Cutter/plotter model

- Scanner brand and model (except FlexiLETTER)

- Any memory-resident programs (TSRs) you may be using

- Other applications installed on your computer

NOTE The quick way to obtain most of this information is to select System Info from the Help menu in 
the upper right of your Flexi window. (This feature is only included in Flexi, not in Cut Manager.)

Once you have gathered this information, call:

Amiable Product Support
Monday-Friday, 10 AM to 7 PM EST

Continental U.S.: (800) 229-9088
Outside the U.S.: (610) 521-6300

Fax: (610) 521-0111



Status Column (Job List)
This column of the Job list indicates whether a job is on hold, ready to be cut or printed, or currently 
cutting or printing. In addition, indicates if an error occurred when sending the file to its final destination 
after cutting or printing.

The following options can appear in the Status column:

Knife:    A cut job is currently being cut or plotted. To pause the job, click Pause; to cancel it, click 
Abort.

Print head:    A print job is currently being printed. To pause the job, click Pause; to cancel it, click
Abort.

Save:    The job is a plot file (*.plt) or print file (*.rtl) that is currently saving to disk. This icon is 
similar to the Knife and Print head, but appears for files sent from the Cut Plot, Fill Plot, or FlexiPRINT 
dialog box in Flexi which are being saved for the first time.

Green light:    The job is waiting to be cut or printed. If Auto start is turned on, the job cuts or 
prints automatically when it reaches the top of the Job list; if Auto start is turned off, the job at the top of 
the list is only sent when you choose Start Job from the File menu or click the Start button.

Green page:    The job is a plot file (*.plt) or print file (*.rtl) that is waiting to be cut, printed, or 
saved. If the file is waiting to cut or print and Auto start is turned on, the job is sent automatically when it 
reaches the top of the Job list; if Auto start is turned off, the job at the top of the list is only sent when you 
choose Start Job from the File menu or click the Start button. If the file is waiting to be saved, Auto start 
has no effect.

Red light:    The job is on hold and will be kept in the Job list until further action is taken:
- To release the hold and place the job on green light or green page status, click the Release

button.

- To remove the job from the Job list, click the Delete button.

Destination error:    The job cut or printed successfully but an error occurred while sending the 
job to the destination indicated in the Dest column. This icon appears when Cut Manager could not save 
or delete the job. For example, this will be displayed if Cut Manager cannot overwrite or delete a read-
only file.

See Also
Auto start

Job list

Buttons



Dest Column (Job List)
This column of the Job list indicates the final destination of the job after it is cut or printed.

To change the destination of a job, choose a different option from the list box in this column.

To change the default destination of the jobs you add to the Job list, use the Preferences 
command on the Edit menu.

NOTE You cannot change the destination of a job that is currently cutting or printing.

The following options are available from this list box:

Archive:    The job will be saved in the default archive directory after it cuts or prints. To change 
the default archive directory, use the Preferences command on the Edit menu. (Plot files and print files 
cannot be archived.)

Delete job:    If the job is a cut job or print job, it will be deleted from the hard drive after it cuts or 
prints. If the job is a plot file or print file, the file you see in the Job list is only a copy; this copy will be 
removed from the Job list and the original will not be deleted.

NOTE Cut jobs and print jobs are temporary files that contain the cutting or printing information for your 
sign. Deleting a job does not affect your original Flexi file.

Hold job: Places a hold on the job after it has plotted or printed and sends it to the bottom of the 
Job list. To cut or print the job again, you must first release it by selecting the job and clicking the Release 
button.

See Also
Preferences

Job List

Buttons



A cut job contains the information created when you cut a color layer or plot all colors using the Cut/Plot 
or Fill Plot dialog box. This includes the path to be cut, the color of vinyl used, the number of copies, the 
media height and length, the vertical and horizontal offset, the vinyl info, and any paneling and registration
marks created in Cut mode in Flexi. You cannot cut a cut job on a plotter whose page length is smaller 
than the length of the plotter selected in the Cut/Plot or Fill Plot dialog box when the job was created.



A plot file is a file in the format needed to plot a file to the currently active plotter. A plot file can be 
created in Flexi by saving a sign to a file from the Cut/Plot or Fill Plot dialog box, by using the Save As 
Native Format command on Cut Manager's File menu, or by importing it from another application. A plot 
file has a *.plt extension and can only be plotted in a single color. Plot files cannot be archived 
automatically.



The Start button on the Cut Manager window sends the job at the top of the Job list to cut or print. This 
button changes to Abort while a job is being cut or printed. For this button to work, the job at the top of the
list must be on ready status (green light).

Cut Manager must be connected to a copy of Flexi for cutting or color printing to be available.



Port List Box (Cut Manager Window)
Shows the name of the displayed port setup and allows you to change which port setup is displayed.

To change which port setup is displayed, choose another port setup from this list box.

To move all the attached plotter setups and printer setups to a different port, choose Port Setup 
from the Port menu and select a new port from the Port list box. (You cannot use Port Setup 
if a job is currently cutting or printing or if there are jobs on ready status and Auto start is 
turned on.) You can only move your setups to a port which does not have another port setup.

To create a new port setup, choose Add Port Setup from the Port menu and then choose either 
Plotter or Printer from the cascading menu. You can only create a port setup on a port which 
does not already have a setup.

To delete a port setup, make sure it is displayed in the Port list box and choose Delete Port Setup 
from the Port menu. If only one port setup has been created, it cannot be deleted.

See Also
Port Setup

Add Port Setup

Delete Port Setup

Auto start



Exit (File Menu)
Closes Cut Manager and ends the current session. Any jobs in the Job list are placed on hold; to cut or 
print them the next time you open Cut Manager, you must release the hold by selecting the job and 
clicking the Release button. (If a job is currently cutting or printing, Cut Manager finishes the job and then 
closes.)

NOTE You do not need to use the Exit command if Cut Manager was opened from a Flexi program. Cut 
Manager closes automatically when all the Flexi programs using it have closed. If you exit Cut 
Manager directly, any Flexi program which is using Cut Manager can no longer cut or print.

See Also
Job list

Release button



The current job status display on the Cut Manager window shows the name and color of the job that is 
currently being cut or printed and the amount of the job that remains to be sent (as a percent of the size 
displayed in the KB column). This area cannot be edited.



Cut Manager Window
The options available in the Cut Manager window allow you to change the displayed port and plotter or 
printer setup, view the Job list for the displayed plotter or printer, control the cut jobs, print jobs, plot files, 
or print files in the list, and send jobs to cut or print. Click on any item in the Cut Manager window shown 
below for a short description of its function; for more complete information, refer to the following topics:

Auto start Port list box

Buttons Setup list box

Job list Status column

Dest column

Click on any item in the window below for more information.



Setup List Box (Cut Manager Window)
Displays the selected plotter setup and lists the plotter and color printer setups available for the displayed 
port setup.

To choose another plotter or color printer setup for the displayed port setup, choose the desired 
setup from this list box.

To choose a plotter or color printer setup from a different port setup, first choose the desired port 
setup from the Port list box and then choose the desired plotter setup from the Setup list box.

To add, delete, or modify a plotter or color printer setup for the displayed port setup, choose Port 
Setup from the Port menu and then choose the appropriate option (Plotter or Printer) from the
cascading menu.

To move a plotter or color printer setup to a different port, change the port setup using the Port 
Setup command on the Port menu.

NOTE You cannot use Port Setup if a job is currently cutting or printing on the displayed port or if there 
are jobs on ready status and Auto start is turned on. You cannot change the device in Port Setup 
if there are jobs in the Job list for that plotter or color printer setup.

See Also
Port Setup

Cut Manager Window

Port list box

Auto start

Job list



Auto start (Cut Manager Window)
Determines whether jobs on ready status (green light) for the displayed port are cut or print automatically 
or must be started manually.

When Auto start is turned on, any job on ready status starts when it reaches the top of the Job list.

When Auto start is turned off, you must choose Start Job from the File menu or click the Start 
button to send the next job on ready status to cut or print.

Auto start is turned off as a safety feature. When Allow remote Send Now/Interactive is selected 
in Preferences and Auto start is turned on in the Cut Manager window, jobs from remote users may start 
unexpectedly! Before turning Auto start on, make sure that all personnel who use the Cut Manager station
are aware that a job can start suddenly; this simple safety can prevent injuries.

See Also
Start Job

Preferences

Job list

Buttons



Job List (Cut Manager Window)
Displays the cut jobs, print jobs, plot files, and print files waiting for the displayed plotter or printer setup. 
This list allows you to enter the number of copies to cut or print, change a job's status, and choose a 
different destination for the job after it is cut or printed. To select a job in this list box, click in the File or 
Color column for the desired job. Additional information for the selected job is available using the Job Info 
command on the File menu.

The following information is displayed in the Job list:

File:    Displays the name of the job. 

- For a cut job or print job, this is the name of the sign followed by a number extension 
indicating the color layer. For example, the cut jobs for a Flexi file named mysign.fs would be
named mysign.000 (bottom layer), mysign.001 (next layer), and so on.

- For a plot file (*.plt) or a print file (*.rtl), this is the name of the file followed by a .000 
extension. For example, a plot file named myplot.plt would appear in the Job list with the 
name myplot.000.

Color:    Displays the color and color name of the job.

- For a cut job for a single color layer which was created using the Cut/Plot or Fill Plot dialog 
box, this column displays the color and color name used for the color in Flexi.

- For a cut job which was created using the Plot all colors option on the Color selection menu 
in the Cut/Plot or Fill Plot dialog box in Flexi, the color is displayed as a rainbow and the color
name is Multiple.

- For a print job which was created using the FlexiPRINT dialog box, the color is displayed as a
rainbow and the color name is CMYK.

- For a plot file (*.plt), no color is displayed and the color name is Unknown.

- For a print file (*.rtl), the color is displayed as a rainbow and the color name is blank.

Length:    Displays the length of a single copy of the job.

Copies:    Displays the number of copies of the job that will be cut or printed. To change this number, type 
directly in the entry box.

Status:    Indicates the status of the job, including whether it is on hold, ready to be cut or printed, or 
currently cutting or printing. In addition, indicates whether an error occurred when sending the file to its 
final destination after cutting or printing.

Dest:    Indicates the final destination of the job after it is cut or printed. To change the destination of a job,
choose a different option from this list box. To change the default destination of the jobs you add to the 
Job list, use the Preferences command on the Edit menu.

NOTE You cannot change the destination of a job that is currently cutting or printing.

KB:    Indicates the total number of kilobytes the job uses on your hard drive. When a job is sent from the 
Cut/Plot, Fill Plot, or FlexiPRINT dialog box in Flexi, this number begins at 0 and increases until the entire 
file is received.

Changing the order of jobs

To move a job up in the Job list, click on its name or color to select it and click on the Up arrow on the 
lower left of the Cut Manager window. You can also use the up arrow key on your keyboard.

- If the job above the selected job has the same file name (or color, if Sort by Color is selected 
in Preferences), the selected job moves up one position in the Job list.

- If the job above the selected job has a different file name (or color, if Sort by Color is selected



in Preferences), all jobs with the same status and name (or color) as the selected job move 
above the previous group in the list.

NOTE A job which is on hold cannot be moved above a job which is on ready status. Also, if a job is 
currently cutting or printing, it must remain at the top of the Job list.

To move a job down in the Job list, click on its name or color to select it and click on the Down arrow in 
the lower left of the Cut Manager window. You can also use the down arrow key on your keyboard.

- If the job below the selected job has the same file name (or color, if Sort by Color is selected 
in Preferences), the selected job moves down one position in the Job list.

- If the job below the selected job has a different file name (or color, if Sort by Color is selected 
in Preferences), all jobs with the same status and name (or color) as the selected job move 
below the previous group in the list.

NOTE A job which is on ready status cannot be moved below a job which is on hold. Also, if a job is 
currently cutting or printing, it must remain at the top of the Job list.

See Also
Job Info

Start Job

Add Job

Preferences

Cut Manager Window

Auto start

Status (Cut List)

Dest (Cut List)

Buttons



Buttons (Cut Manager Window)
The buttons at the bottom of the Cut Manager window allow you to change the order of your jobs, control 
cutting and printing, change the status of a job, delete a job, and/or communicate with your plotter or 
printer.

Several of the buttons in the Cut Manager window have two different functions which toggle according to 
what is selected in the Job list. (For example, Hold and Release are on the same button, so if you select a
file on ready status, it displays Hold, and if you select a held file, it displays Release.) These buttons are 
discussed together, with each pair separated by a dividing line.

The following buttons are included in the Cut Manager window:

Moves the selected job up in the Job list. (To select a job, click on its name or color in the Job list.) You 
can also use the up arrow key on your keyboard.

- If the job above the selected job has the same file name (or color, if Sort by Color is selected 
in Preferences), the selected job moves up one position in the Job list.

- If the job above the selected job has a different file name (or color, if Sort by Color is selected
in Preferences), all jobs with the same status and name (or color) as the selected job move 
above the previous group in the Job list.

NOTE A job which is on hold cannot be moved above a job which is on ready status. Also, if a job is 
currently cutting or printing, it must remain at the top of the Job list.

Moves the selected job down in the Job list. (To select a job, click on its name or color in the Job list.) You 
can also use the down arrow key on your keyboard.

- If the job below the selected job has the same file name (or color, if Sort by Color is selected 
in Preferences), the selected job moves down one position in the Job list.

- If the job below the selected job has a different file name (or color, if Sort by Color is selected 
in Preferences), all jobs with the same status and name (or color) as the selected job move 
below the previous group in the Job list.

NOTE A job which is on ready status cannot be moved below a job which is on hold. Also, if a job is 
currently plotting, it must remain at the top of the Job list.

Sends the job at the top of the Job list to cut or print; changes to Abort while a job is being plotted. For 
this button to work, the job at the top of the list must be on ready status (green light). In addition, Cut 
Manager must be connected to a copy of Flexi for cutting or color printing to be available.

NOTE You can also send a job to cut or print by selecting Start Job from the File menu.

Stops the job which is currently plotting or printing; changes to Start when the job at the top of the list is 
on ready status (green light), but is not plotting or printing. The aborted job is placed on hold and moved 
to the bottom of the Job list.

Temporarily stops the job which is currently plotting or printing; changes to Continue when a job is 
paused. A paused job remains at the top of the Job list; no other job can be cut or printed until the job is 
resumed (by clicking the Continue button) or aborted (by clicking the Abort button).



Resumes cutting or printing a job which has been paused; changes to Pause when you click it to restart 
the job.

Places the selected job on hold status and moves it to the bottom of the Job list; changes to Release 
when a job on hold is selected. (To select a job, click on its name or color in the Job list.) Jobs which are 
on hold cannot be cut or printed until the hold is released.

NOTE A job which is currently cutting or printing cannot be placed on hold status. To stop a job which is 
currently plotting, either abort it using the Abort button or pause it using the Pause button.

Releases the hold on the selected job and places it on ready status (green light); changes to Hold when a
job on ready status is selected. (To select a job, click on its name or color in the Job list.) Jobs which have
been released move above all of the jobs which are still on hold and below any other jobs on ready 
status.

TIP If you release a job and you wish to cut or print it before the other jobs in the Job list, move it 
higher in the list by selecting it and clicking the Up Arrow button.

Removes the selected job from the Job list before it cuts or prints. (To select a job, click on its name or 
color in the Job list.)

- If the selected job is a cut job or print job in Flexi format, clicking Delete deletes it from your 
hard drive. To remove it from the Job list and save it so it can be plotted or printed later, 
choose the Save Job command on the File menu.

- If the selected job is a plot file or print file, clicking Delete removes the job from the Job list, 
but keeps it available on your hard drive in its original location. To load it into the Job list 
again, choose the Add Job command on the File menu.

Moves the pen/knife around the border of the first page of the job at the top of the Job list without cutting 
it. For this option to work, Cut Manager must be connected to a copy of Flexi. This button is only available
for cut jobs; it is dimmed when a print job is selected.

Returns information on the actual height and length of the currently loaded media and displays it above 
the preview display. This button is only available for cut jobs; it is dimmed when a print job is selected.

NOTE For interactive features such as Show Me and Poll Size to work, your plotter must be turned on, 
on line, and connected to a serial port, and your media must be loaded. Not all plotters support 
interactive features. See the manual for your plotter for more information.

See Also
Start Job

Add Job

Preferences

Cut Manager Window

Status (Cut Job List)



Dest (Cut Job List)



A remote computer is any computer on the network other than the current one. For example, a 
Flexi program on another computer that is using this Cut Manager is called a remote Flexi. 



For cutting or color printing to be available, Cut Manager must be connected to a copy of Flexi. This 
means that there must be an open version of Flexi which is using this Cut Manager.

- If you are using Cut Manager and Flexi on the same computer, opening Flexi opens Cut 
Manager automatically. If Cut Manager has exited for any reason, it opens when you choose 
Cut/Plot from the File menu in Flexi or click the Cut tool on the Draw palette.

If Cut Manager is installed as a stand-alone application on a Windows for Workgroups network, 
you must open Flexi on one of the computers on your network and choose the appropriate Cut Manager 
using the Cut Manager option of the Setup command from the Edit menu in Flexi. Once this is done, you 
will be able to cut from the selected Cut Manager.



The Pause button on the Cut Manager window pauses the job which is currently cutting or printing. This 
button changes to Continue when a job is paused. A paused job remains at the top of the Job list and no 
other job can be sent to cut or print until the job is resumed (by clicking the Continue button) or aborted 
(by clicking the Abort button).



The Release button releases the hold on the selected job and places it on ready status (green light); this 
button changes to Hold when a job on ready status is selected. (To select a job, click on its name or color 
in the Job list.) Jobs which have been released move above all the jobs which are still on hold and below 
any other jobs on ready status.



The Hold button places the selected job on hold and moves it to the bottom of the Job list; this button 
changes to Release when a job on hold is selected. (To select a job, click on its name or color in the Job 
list.) Jobs on hold cannot be cut or printed until the hold is released.

A job which is currently cutting or printing cannot be placed on hold. To stop a job which is currently 
cutting or printing, either abort it using the Abort button or pause it using the Pause button.



The Delete button removes the selected job from the Job list before it cuts or prints. (To select a job, click
on its name or color in the Job list.)

- If the selected item is a cut job or print job, clicking Delete removes it from your hard drive.

- If the selected job is a plot file or print file, clicking Delete removes the job from the Job list, 
but keeps it available on your hard drive in its original location.



The Up arrow on the Cut Manager window moves the selected job up in the Job list. (To select a job, 
click on its name or color in the Job list.) You can also use the up arrow key on your keyboard.

- If the job above the selected job has the same file name (or color, if Sort by Color is selected 
in Preferences), the selected job moves up one position in the Job list.

- If the job above the selected job has a different file name (or color, if Sort by Color is selected
in Preferences), all jobs with the same status and name (or color) as the selected job move 
above the previous group in the list.

A job which is on hold cannot be moved above a job which is on ready status. Also, if a job is currently 
plotting, it must remain at the top of the Job list.



The Down arrow on the Cut Manager window moves the selected job down in the Job list. (To select a 
job, click on its name or color in the Job list.) You can also use the down arrow key on your keyboard.

- If the job below the selected job has the same file name (or color, if Sort by Color is selected 
in Preferences), the selected job moves down one position in the Job list.

- If the job below the selected job has a different file name (or color, if Sort by Color is selected 
in Preferences), all jobs with the same status and name (or color) as the selected job move 
below the previous group in the list.

A job which is on ready status cannot be moved below a job which is on hold. Also, if a job is currently 
plotting or printing, it must remain at the top of the Job list.



The Show Me button moves the pen/knife around the border of the first page of the job at the top of the 
Job list without cutting it. (Cut jobs only.)

For Show Me to work, Cut Manager must be connected to a copy of Flexi, your plotter must be turned on, 
on line, and connected to a serial port, and your media must be loaded. Also, not all plotters support 
interactive features. See your plotter's user manual for more information.



When a plotter setup is active, the Poll Size button returns information on the actual height and length of 
the currently loaded media and displays it above the preview display. This button is dimmed when a color 
printer setup is active.

For Poll Size to work, Cut Manager must be connected to a copy of Flexi, your plotter must be turned on, 
on line, and connected to a serial port, and your media must be loaded. Also, not all plotters support 
interactive features. See your plotter's user manual for more information.



A print file is a file in the format needed to print a file to the currently active printer. A print file can be 
created in Flexi by saving a sign to a file from the FlexiPRINT dialog box or by using the Save As Native 
Format command on Cut Manager's File menu. A print file has a *.rtl extension. Print files cannot be 
archived automatically.



A print job contains the information created when you print a file using the FlexiPRINT dialog box. This 
includes the rasterized image itself, the media size and type, the ink type, the number of copies, the 
vertical and horizontal offset, and any contouring information.



Edit Menu Commands
Select All

Preferences



Select All (Edit Menu)
Selects all of the jobs in the Job list. This option is useful when you wish to click one of the buttons on the 
Cut Manager window to release, hold, or delete all of the jobs in the list at the same time.

See Also
Cut Manager window



The Port List Box changes the displayed port setup. To change the displayed port setup (and move all of
its associated plotter and printer setups), choose another port setup from this list box.



The Abort button stops the job which is currently plotting or printing; this button changes to Start when 
no job is plotting or printing. The aborted job is placed on hold and moved to the bottom of the Job list.



The Setup List box displays the selected plotter or color printer setup. To choose another plotter or color 
printer setup on the displayed port setup, choose the desired plotter or printer from this list box.



The Auto start checkbox controls how jobs are cut or printed. When this option is selected, jobs on ready
status (green light) start automatically when they reach the top of the Job list. When this option is 
deselected, you must click the Start button at the bottom of the Cut Manager window or choose Start Job 
from the File menu to send the next job on ready status to cut or print.



The Media height/length items on the Cut Manager window display the size of the currently loaded 
media. These values can be changed by

- Clicking the Poll Size button at the bottom of the Cut Manager window (cutters and plotters 
only)

- Changing the plotter or printer setup by choosing the Port Setup command from the Port 
menu

- Changing the size for a specific cut job only by displaying the Plotter Options dialog box by 
clicking Options in the Cut/Plot or Fill Plot dialog box (cutters and plotters only)

- Changing the size for a specific print job only by changing it in the FlexiPRINT dialog box 
(color printers only)



The File column in the Job list displays the name of the job. To select a job, click in this column or the 
Color column.



Save As Native Format... (File Menu)
Saves the selected job in the format used by the active plotter or printer setup (according to whether a cut
job or print job is selected) and then removes the job from the Job list. This command is very useful when 
you need to provide an electronic file to a customer who does not have Flexi.

- A cut job is saved to a plot file that has the extension *.plt. This file can be used by any 
software which can communicate with the plotter selected in the active plotter setup.

- A print job is saved to a print file with the extension *.rtl. This file can be used by any 
software which can communicate with the color printer selected in the active printer setup. 
(FlexiSIGN-PRO only.)

To save the selected job to the specified name and location and remove it from the Job list without cutting 
or printing it, use the Save Job command.

See Also
Save Job

Preferences

Cut Manager Window

Job list



The Color column in the Job list displays the color of the job. To select a job, click in this column or the 
File column.

[Color name] indicates a cut job that is a single color layer in Flexi format.

Multiple indicates a cut job that was created in Flexi using the Plot All Colors option on the Color 
selection menu in the Cut/Plot or Fill Plot dialog box.

CMYK indicates a print job that was created in Flexi using the FlexiPRINT dialog box.

Blank color indicates a plot file (*.plt) or a print file (*.rtl) which was created in Flexi 
using the Save to File option or that was created in another application.



The Length column in the Job list displays the length of a single copy of the job.



The Copies column in the Job list displays the number of copies that will be cut or printed. To change 
this number, type directly in the entry box and then press Tab.



The Status column in the Job list indicates the job's status:

Knife:    A cut job is currently being cut.

Print head:    A print job is currently being printed.
Green light:    The job is ready and waiting to be cut or printed.
Red light:    The job is on hold and will be kept in the Job list until you select and click either the 

Release button (changing it to ready) or the Delete button.
Save:    The job is a plot file (*.plt) or print file (*.rtl) that is currently saving to disk.
Green page:    The job is a plot file (*.plt) or print file (*.rtl) that is waiting to be cut, printed, or 

saved.
Destination error:    The job cut or printed successfully but an error occurred while sending the 

job to the destination indicated in the Dest column.



The Dest column in the Job list indicates the final destination of the job after it is cut. The default 
destination is determined by the Cut Manager Preferences, or you can change it by picking a different 
option from the Dest list box:

Archive: The cut job will be saved in the default archive directory after it cuts or plots. To change 
the default archive directory, use the Preferences command on the Edit menu.

Delete cut job: If the job is a cut job in Flexi format, it will be deleted from the hard drive after it 
cuts or plots. If the job is a plot file (*.plt) in HPGL format, the file you see in the Job list is only a copy; the
original is not deleted.

Hold cut job: Places a hold on the job after it has plotted and sends it to the bottom of the Job 
list. To cut the job again, you must first release it by selecting the job and clicking the Release button.



The KB column in the Job list indicates the total size (in kilobytes) of the job received from Flexi.



Plotter... (Port Setup, Port Menu)
Allows you to create, modify, and delete plotter setups on the displayed port setup as well as to move the 
port setup to another port. Before plotting your first sign, you need to create a setup for each of the cutters
or plotters that will use each port. Each plotter setup contains the brand and model of the plotter, the 
height and width of the plotting area, and how the plotter will communicate with your computer.

NOTE You can also display the Port Setup dialog box from Flexi by choosing the Plotter option from the 
Setup cascading menu on the Edit menu. You cannot display Port Setup if a job is currently 
cutting or printing to the displayed port or if there are jobs on ready status and Auto start is turned
on.

Click on any item in the dialog box below for more information.

See Also
Add Port Setup

Delete Port Setup

Cut Manager Window



Printer... (Port Setup, Edit Menu)    
Allows you to create, modify, and delete printer setups on the displayed port setup or to select a different 
port for the port setup.

NOTE You can also display the Port Setup dialog box from Flexi by choosing the Color Printer option 
from the Setup cascading menu on the Edit menu. You cannot display Port Setup if a job is 
currently cutting or printing to the displayed port or if there are jobs on ready status and Auto start
is turned on.

Click on any item in the dialog box below for more information.

See Also
Add Port Setup
Delete Port Setup
Cut Manager Window



A contour job is created when you use the FlexiPRINT dialog box to print an image that includes a 
contour created using FlexiSIGN-PRO's Contour command. It contains the information needed by the 
cutter to accurately place and cut a contour around the printed image.



The Media height/length items display the height and length of the active printer's default media.

To change the default media size, click the Material/Ink button.



Material/Ink Setup    
Allows you to change the items listed for media type, media size, and ink type for each color printer setup.
You can add, delete, or modify items in each list. This dialog box also allows you to adjust Flexi's ink 
tracking system.

To display the Material/Ink Setup dialog box, click the Material/Ink button in Color Printer Setup.

Click on any item in the dialog box below for more information.

Return to Color Printer Setup

See Also
Color Printer Setup

Ink Tracking Calibration



Ink Tracking Calibration    
Adjusts the ink tracking formula for the selected color to allow for an individual printer's rate of ink usage. 
FlexiSIGN-PRO's ink tracking system assumes that your printer is working under normal operating 
conditions. However, several conditions can have a profound effect on how rapidly ink is used, including 
temperature or humidity, age or condition of an ink cartridge, or individual printer performance.

To display the Ink Tracking Calibration dialog box for one of the ink colors, click one of the ink color 
buttons in Material/Ink Setup.

CAUTION If you are only making a one-time change, such as when you refill a cartridge, do not use the 
Ink Tracking Calibration dialog box. Instead, simply enter the corrected value in the 
Remaining entry box found in the Material/Ink Setup dialog box.

Click on any item in the dialog box below for more information.

Return to Material/Ink Setup



Plotter... (Add Port Setup, Port Menu)
Allows you add a new port setup on any unused port and create plotter setups for the new port setup.    
Each plotter setup contains the brand and model of the plotter, the height and width of the plotting area, 
and how the plotter will communicate with your computer.

Click on any item in the dialog box below for more information.

See Also
Help
Port Setup

Add Port Setup

Delete Port Setup

Cut Manager window



Printer... (Add Port Setup, Port Menu)    
Allows you to create a new port setup on any unused port and then create a color printer setup to use on 
that port.

NOTE If you want to move existing setups to a different port or create a new printer setup on an existing 
port (for example, lpt1), use the Port Setup command.

Click on any item in the dialog box below for more information.

See Also
Material/Ink Setup

Port Setup

Add Port Setup



The New Setup button creates a new setup that is called 'User Setup'.    Type a new name in the Setup 
list box if desired.



The Send arc/curve commands checkbox allows you to take advantage of the internal curve handling of
certain plotters.

See your plotter manual to determine whether this option is available with your plotter.



The Delete Setup button removes the currently displayed setup from the port setup.



The Device list box allows you to choose a device for a new setup or change the device for an existing 
setup.



Displays the current color printer setup's maximum page length.



The Media list box allows you to choose the default media for the current color printer setup.



The Ink list box allows you to choose the default ink for the current color printer setup.



The Size list box allows you to choose the default size for the current color printer setup. The sizes 
available depend on which media you have selected.



The Communications button displays all of the communications settings for the current setup.

Check your device's user manual to make sure that these settings are correct.



The Material/Ink button displays the Material/Ink Setup dialog box. This dialog box allows you to change 
the items included in the Media, Size, and Ink list boxes and to adjust ink tracking.



The Cancel button closes the dialog box without saving any changes you made.



The OK button saves any changes you made and closes the dialog box.



The Port list box allows you to choose a different port for the active port setup. Only ports which do not 
already have a setup are displayed in this list box. If you change the port setting, it will change for all of 
the associated plotter and color printer setups.



The Setup list box displays the name of the currently selected setup.    You can change the name by 
clicking in this entry box and typing.    You can also display a different setup by holding down the arrow 
next to the list box.



The Knife offset checkbox allows Flexi to compensate for the differences between how a pen plots and a
knife cuts on older pen plotters. The correct offset depends on the size of the blade and the thickness of 
the media being used.

Check your cutter's user manual for the best setting for your cutter.



The Media list box displays all of the available media types for the currently selected printer. (For 
example, media types for a NovaJET include PhotoGloss and Backlit Heavy.) To change the name of the 
selected media type, highlight it and type the new name.



The Send packets N K bytes checkbox allows you to control the size of the data packets sent to certain 
cutter/plotters with no handshaking.

This option is not available for all cutter/plotters.



The Height entry box allows you to specify the default media height.

Do not increase this value beyond your plotter's maximum page height.



The Length entry box allows you to specify the default media length.

Do not increase this value beyond your cutter's maximum page length, or your media may skew when 
cutting. If your sign is longer than your cutter's recommended page length, Flexi will automatically split the
sign into pages when it is paneled.



The Poll Size button displays the actual height and length of the currently loaded media in the Height 
and Length entry boxes.

For Poll Size to work, Cut Manager must be connected to a copy of Flexi, your plotter must be turned on, 
on line, and connected to a serial port, and your media must be loaded. Also, not all plotters support 
interactive features. See your plotter's user manual for more information.



The Ink list box displays all of the available inks for the currently selected media and printer. To change 
the name of the selected ink, highlight it and type the new name.



The Delete Media button deletes the media type that is currently displayed.



The New Media button adds a new media type based on the current media displayed. For example, if 
PhotoGloss is displayed, clicking this button creates a new media type called PhotoGloss-1.



The Height entry box displays the height of the currently displayed media size. To change the height, 
type a new number in the entry box.



The Length entry box displays the length of the currently displayed media size. To change the length, 
type a new number in the entry box.

Do not attempt to increase the page length beyond your printer's default! Often the printer's tracking is 
affected when you try to print a longer page, resulting in the media skewing in the printer. If your design is
longer than your printer's recommended page length, Flexi automatically splits the sign into pages when it
is paneled.



The Size list box displays all of the available sizes for the currently selected media and printer. To 
change the name of the selected size, highlight it and type the new name.



The Ink color buttons display the color (C, M, Y, K) for each of the Remaining and Capacity entry boxes. 
To adjust a color's calibration formula, click on its button to display the Ink Tracking Calibration dialog box.



The Remaining entry boxes display the estimated amount of ink remaining for each color as a 
percentage of the total capacity. (If your printer's ink cartridge holds 42 mL and Flexi estimates that only 
4.2 mL remain, this entry box shows 10%.) To change this number, type in the correct percentage.

If you just replaced or refilled a cartridge, type 100% in the entry box for that color.



The Capacity entry boxes display the total amount each cartridge or ribbon can hold. This number does 
not change unless you type in a new number.



The New Ink button adds a new ink based on the current ink displayed. For example, if YMCK Inkjet 
Cartridge is displayed, clicking this button creates a new ink called YMCK Inkjet Cartridge-1.



The Delete Ink button deletes the ink that is currently displayed.



The New Size button adds a new size based on the current size displayed. For example, if Standard is 
displayed, clicking this button creates a new size called Standard-1. The new size will have the same 
Height and Length as the size it was based on.



The Delete Size button deletes the size which is currently displayed.



The color preview shows which color's (C, M, Y, K) ink tracking formula you are editing.



The Dots/ml entry box displays the number of dots Flexi assumes is printed for every milliliter of ink. 
Changing this number permanently changes Flexi's ink usage formula for this color. Any changes made to
this entry box are automatically reflected in the % ink remaining in cartridge entry box (unless there is 
100% remaining), and any changes made in the % ink remaining in cartridge entry box are reflected in 
this entry box.



The % ink remaining in cartridge entry box displays the current percentage of ink remaining for the 
selected color. Changing this number permanently changes Flexi's ink usage formula for this color. Any 
changes made to this entry box are reflected automatically in the Dots/ml entry box, and any changes 
made in the Dots/ml entry box are reflected automatically in this entry box.



The Default button returns the Dots/ml setting to its default and adjusts the % ink remaining in cartridge 
entry box to match the new setting.






